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Choose the correct answer:

1. The term ‘Computer’ is derived from..........

a. Latin b. German

c. French d. Arabic

2. Who is the father of Computer?

a. Allen Turing b. Charles Babbage

c. Simur Cray d. Augusta Adaming

4. Who is the father of Computer science?

a. Allen Turing b. Charles Babbage

c. Simur Cray d. Augusta Adaming

5. Who is the father of personal computer?

a. Edward Robert b. Allen Turing

c. Charles Babbage d. None of these

6. A CPU contains

a. a card reader and a printing device

b. an analytical engine and a control unit

c. a control unit and an arithmetic logic unit

d. an arithmetic logic unit and a card reader

7..........is a combination of hardware and software that facilitates the sharing of information

between computing devices.

a. network b. peripheral

c. expansion board d. digital device.

8. Which of the following statements is true ?

a. Minicomputer works faster than Microcomputer

b. Microcomputer works faster than Minicomputer

c. Speed of both the computers is the same

d. The speeds of both these computers cannot be compared with the speed of

advanced

9. You organize files by storing them in

a. archives b. folders

c. indexes d. lists

10. Which of the following is a part of the Central Processing Unit?

a. Printer b. Key board

c. Mouse d. Arithmetic & Logic unit

11. UNIVAC is

a. Universal Automatic Computer

b. Universal Array Computer

c. Unique Automatic Computer

d. Unvalued Automatic Computer

12. CD-ROM stands for

a. Compactable Read Only Memory

b. Compact Data Read Only Memory

c. Compactable Disk Read Only Memory

d. Compact Disk Read Only Memory

13. ALU is

a. Arithmetic Logic Unit b. Array Logic Unit

c. Application Logic Unit d. None of above

14. VGA is

a. Video Graphics Array b. Visual Graphics Array

c. Volatile Graphics Array d. Video Graphics Adapter



M I T  C o m p u t e r  C e n t r e 4/2

F u n d a m e n t a l s  o f  C o m p u t e r  ( D C A  - 1 0 1 )

15. IBM 1401 is

a. First Generation Computer b. Second Generation Computer

c. Third Generation Computer d . Fourth Generation Computer

16. MSI stands for

a. Medium Scale Integrated Circuits

b. Medium System Integrated Circuits

c. Medium Scale Intelligent Circuit

d. Medium System Intelligent Circuit

17. CAD stands for

a. Computer aided design b. Computer algorithm for design

c. Computer application in design d. Computer analogue

18. What characteristic of read-only memory (ROM) makes it useful?

a. ROM information can be easily updated.

b. Data in ROM is non-volatile, that is, it remains there even without

electrical power.

c. ROM provides very large amounts of inexpensive data stor age.

d. ROM chips are easily swapped between different brands of computers.

19. Which of the following is a storage device?

a. Tape b. Hard Disk

c. Floppy Disk d. All of the above

20. Which of the following is first generation of computer?

a. EDSAC b. IBM-1401

c. CDC-1604 d. ICL-2900

21. Chief component of first generation computer was

a. Transistors b. Vacuum Tubes and Valves

c. Integrated Circuits d. None of above

22. Second Generation computers were developed during

a. 1949 to 1955 b. 1956 to 1965

c. 1965 to 1970 d. 1970 to 1990

23. The computer size was very large in

a. First Generation b. Second Generation

c. Third Generation d. Fourth Generation

24. Microprocessors as switching devices are for which generation computers

a. First Generation b. Second Generation

c. Third Generation d. Fourth Generation

25. Which of the following devices can be sued to directly image printed text?

a. OCR b. OMR

c. MICR d. All of above

26. The output quality of a printer is measured by

a. Dot per inch b. Dot per sq. inch

c. Dots printed per unit time d. All of above

27. In analogue computer

a. Input is first converted to digital form

b. Input is never converted to digital form

c. Output is displayed in digital form

d. All of above

28. In latest generation computers, the instructions are executed

a. Parallel only b. Sequentially only

c. Both sequentially and parallel d. All of above
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29. Who designed the first electronics computer – ENIAC?

a. Van-Neumann b. Joseph M. Jacquard

c. J. Presper Eckert and John W Mauchly

d. All of above

30. Modern Computer are very reliable but they are not

a. Fast b. Powerful

c. Infallible d. Cheap

31. What is the name of the display feature that highlights are of the screen which requires

operator attention?

a. Pixel b. Reverse video

c. Touch screen d. Cursor

32. Personal computers use a number of chips mounted on a main circuit board. What is the

common name for such boards?

a. Chipset board b. Motherboard

c. Circuit board d.Breadboard

33. In most IBM PCs, the CPU, the device drives, memory expansion slots and active compo-

nents are mounted on a single board. What is the name of this board?

a. Motherboard b. Breadboard

c. Circuit board d. Chipset board

34. What is meant by a dedicated computer?

a. Which is used by one person only

b. Which is assigned one and only one task

c. Which uses one kind of software

d. Which is meant for application software

35. The system unit of a personal computer typically contains all of the following except:

a. Microprocessor b. Disk controller

c. Serial interface d. Modem

36. Which of the following are input devices?

a. Keyboard b. Mouse

c. Card reader d. Any of these

37. Examples of output devices are

a. Screen b. Printer

c. Speaker d. All of these

38. Which of the following is also known as brain of computer

a. Control unit b. Central Processing unit

c. Arithmetic and language unit d. Monitor

39. A ............ is a microprocessor -based computing device.

a. personal computer b. mainframe

c. workstation d. server

40. RAM can be treated as the ......... for the computer's processor

a. factory b. operating room

c. waiting room d. planning room

41. A device, which is not connected to CPU, is called as .......

a. land-line device b. On-line device

c. Off-line device d. Device

42. On-line real time systems become popular in ........... generation

a. First Generation b. Second Generation

c. Third Generation d. Fourth Generation
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43. You use a(n) ....., such as a keyboard or mouse, to input information

a. output device b. input device

c. storage device d. processing device

44. ALU and Control Unit jointly known as

a. RAM b. ROM

c. CPU d. PC

45. RAM is an example of

a. Secondary memory b. Primary memory

c. Main memory d. Both (1) and (2)

46. Magnetic disk is an example of

a. Secondary memory b. Primary memory

c. Main memory d. Both (1) and (2)

47. RAM is also called as

a. Read / Write Memory b. Long Memory

c. Permanent Memory d. Primary Memory

48. The CPU and memory are located on the :

a. expansion board b. motherboard

c. storage device d. output device

49. Where does most data go first with in a computer memory hierarchy ?

a. RAM b. ROM

c. BIOS d. CACHE

50. Reusable optical storage will typically have the acronym-

a. CD b. DVD

c. ROM d. RW

51. The most common type of storage devices are-

a. Steel b. optical

c. magnetic d. flash

52. A DVD is an example of a (n)-

a. hard disk b. optical disc

c. output device d. solid-state storage device

53. Which of the following does not store data permanently?

a. ROM b. RAM

c. Floppy Disk d. Hard Disk

54. In a computer, most processing takes place in

a. Memory b. RAM

c. motherboard d. CPU

55. Cathode Ray Tube is a form of.......

a. Keyboard b. Mouse

c. Monitor d. Mother board

56. Note book, laptop,palm,hand-held computers are coming under the category of.........

computer

a. Digital computer b. Mainframe computer

c. Portable computer d. Hybrid computer

57. Light pen and joystick are............

a. Algorithm b. Input devices

c. Output devices d. Portals

58. Touch Screen is............

a. Input device b. Output device

c. Both a & b above d. None of these
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Choose the correct answer:

1. The operating system is an example of a computer______.

a. object  b. file system

c. program  d. desktop

2. Most operating systems are comprised of three main components: the _______, the file system,

and the

shell.

a. desktop b. kernel

c. user interface d. code

3. The ______ keeps track of directories and files.

a. kernel b. file system

c. shell d. user interface

4. Most often, you click with the ______ button when you want to select something.

a. middle b. left

c. right d. all of the above

5. Before the days of Windows, users interfaced with the operating system through a ________

interface.

a. graphical b. object oriented

c. command utility d. command line

6. The _______ is often used as part of a path.

a. comma b. forward slash

c. backslash d. semicolon

7. The ______ is often used in a switch.

a. comma b. forward slash

c. backslash d. semicolon

8. The ______ is the entire window that fills your computer screen and its contents.

a. System Tray b. Taskbar

c. Desktop d. Quick Launch Toolbar

9. A quicker way to launch a program is to click on it in the _______.

a. System Tray b. Taskbar

c. Desktop d. Quick Launch Toolbar

10. The ______ lets you move between applications without having to open and close them all the

time.

a. System Tray b. Taskbar

c. Desktop d. Quick Launch Toolbar

11. You will find the clock and icons for certain applications in the ___.

a. System Tray b. Taskbar

c. Desktop d. Quick Launch Toolbar

12. ___ allow(s) us to organize our files so we can more easily find them

a. Navigation b. Folders

c. Desktop d. None of the above

13. ______ is the default place that most applications want to store your data files in.

a. Start menu b. Recycle Bin

c. Program Files d. My Documents

14. _______ is referred to as a path using the proper syntax.

a. c;windows/desktop

b. c:>

c. c:\windows\desktop\My Documents

d. c:winnt/system32
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15. The Recycle Bin is configured automatically to be able to store files equal to ______ of the size

of your hard disk.

a. 1 percent b. 5 percent

c. 10 percent d. 15 percent

16. ______ was really designed for users who also have a notebook computer and often work in

files in

two different places.

a. Briefcase b. Suitcase

c. Desktop d. Start menu

17. _______ keeps track of the computers around you in a networked environment.

a. My Computers b. FTP

c. Add Network Place d. My Network Places

18. If you right click on a file or folder, one of the context menu options is ______.

a. remote b. send to

c. copy to d. rename to

19. You can drop a file onto the start button to add it to the ______.

a. Quick Launch Toolbar

 b. Taskbar

c. Start menu

d. Recycle Bin

20. Many operating system directory structures are _________.

a. discrete b. disparate

c. virtual d. hierarchical

21. ____of a directory structure is the topmost directory on the disk.

a. root b. tree

c. subdirectory d. base

22. If you prefer to ____ on a file versus ____, you can configure that setting by going into Tools,

Folder

Options.

a. single click/double click

b. double click/ single click

c. both of the above

d. none of the above

23. _____ Explorer is a Web browser that allows to more easily navigate the Internet.

a. Windows b. Netscape

c. Internet d. Microsoft

24. _____ Explorer is a tool that lets you more easily navigate the files and folders on your com-

puter.

a. Windows b. Netscape

c. Internet d. Microsoft

25. A floppy disk can hold _____ when it is formatted.

a. 2.0 MB b. 1.44 KB

c. 1.44 MB d. 2.0KB

26. Examples of file ____ are read only, hidden, and archive.

a. types b. sizes

c. attributes d. formats

27. If you ____ a file you now have more than one instance of it; if you _____ a file, you only have

one

instance of it.

a. borrow/delete b. move/copy

c. copy/move d. none of the above
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28. Each copy of the file is referred to as a different ______ of the file.

a. attribute b. element

c. version d. facet

29. The ___ wildcard is used to replace an infinite number of characters.

a. ! b. ?

c. * d. &

30. The ____ wildcard is used to replace a single character.

a. ! b. ?

c. * d. &

31. To select noncontiguous files, hold down the ___ key when selecting the files.

a. Alt b. Ctrl

c. Shift d. Space Bar

32. If there are multiple recycle bin for a hard disk

a. you can set different size for each recycle bin

b. you can choose which recycle bin to use to store your deleted files

c. You can make any one of them default recycle bin

d. None of above

33. Identify false statement

a. You can find deleted files in recycle bin

b. You can restore any files in recycle bin if you ever need

c. You can increase free space of disk by sending files in recycle bin

d. You can right click and choose Empty Recycle Bin to clean it at once

34. If the displayed system time and date is wrong, you can reset it using

a. Write b. Calendar

c. Write file d. Control panel

35. You should save your computer from?

a. Viruses b. Time bombs

c. Worms d. All of the above

36. A co-processor

a. Is relatively easy to support in software

b. Causes all processor to function equally

c. Works with any application

d. Is quite common in modern computer

37. A Microsoft Windows is ..... a(n)

a. Operating system b. Graphic program

c. Word Processing d. Database program

38. Which of the following is program group?

a. Accessories b. Paint

c. Word d. All of above

39. Which is not application software?

a. Windows NT b. Page Maker

c. WinWord XP d. Photoshop

40. Which of the following is an example of a real time operating system?

a. Lynx b. MS DOS

c. Windows XP d. Process Control

12. Which of the following operating system does not implement the multitasking truly?

a. Windows 98 b. Windows NT

c. Windows XP d. MS DOS

13. Which of the following windows version support 64 bit processor?

a. Windows 98 b. Windows 2000

c. Windows XP d. Windows 95
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14. Which of the following Operating System does not implement multitasking truly?

a. Windows 98 b. Windows NT

c. Windows XP d. MS DOS

15. What program runs first after computer is booted and loading GUI?

a. Desktop Manager b. File Manager

c. Windows Explorer d. Authentication

16. Which of the following operating system do you choose to implement a client server network?

a. MS DOS b. Windows

c. Windows 98 d. Windows 2000

17. Which of the following Operating systems is better for implementing a Client-Server

network

a. MS DOS b. Windows 95

c. Windows 98 d. Windows 2000

18. My Computer was introduced from

a. Windows 3.1 b. Windows 3.11

c. Windows 95 d. Windows 98

19. Which of the following Windows do not have Start button

a. Windows Vista b. Windows 7

c. Windows 8 d. None of above

20. Which is the latest version of MS Windows?

a. Windows 2007 b. Windows 10

c. Windows 2008 d. Windows 7

21. Which operating system doesn’t support networking between computers?

a. Windows 3.1 b. Windows 95

c. Windows 2000 d. Windows NT

22. Which Operating System doesn’t support networking between computers?

a. Windows 3.1 b. Windows 95

c. Windows 2000 d. Windows NT

23. Which of the following does not support more than one program at a time?

a. DOS b. Linux

c. Windows d. Unix

24. Which of the following is not an operating system?

a. DOS b. Linux

c. Windows d. Oracle

25. Linux is a(n) ... operating system

a. Open source b. Microsoft

c. Windows d. Mac

26. Which operating system can you give smallest file name?

a. Ps/2 b. Dos

c. Windows d. Windows NT

27. Which one is not operating system?

a. P11 b. OS/2

c. Windows d. Unix

28. Which of the following is not a multitasking operating system?

a. Windows b. Linux

c. Win NT d. DOS

32. Which one is not a system tool?

a. Backup b. Disk defragment

c. Virus scanning d. All of the above
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34. The operating system creates ... from the physical computer

a. Virtual space b. Virtual computer

c. Virtual device d. None

35. The operating system creates _____ from the physical computer

a. Virtual space b. Virtual computers

c. Virtual device d. None

40. Which command is used to see the version of operating system?

a. Vol b. Version

c. Ver d. None of the above

42. Which of the following is system software?

a. Operating system b. Compiler

c. Utilities d. All of the above

44. A ....is a flash memory storage device that plugins into a USB port

a. USB snap drive

b. USB flash drive

c. USB memory maker drive

d. None of above

45. The ....is the drive containing the files to be copied

a. Source drive

b. Destination drive

c. USB drive

d. None of the above

51. Which command is used to display the contents of the text file of DOS?

a. Copy con b. Copy

c. Type d. Dir

52. In Windows, start button is used to

a. Run applications

b. Device setting

c. Turn off the system

d. All of above

56. What is the function of radio button?

a. To select multiple option

b. To select single option

c. To select all option

d. All of above

71. Recently deleted files are stored in

a. Recycle bin b. Desktop

c. Taskbar d. My computer

72. Which components appear in the initial Windows start up display?

a. Dialog boxes b. Start menu

c. Taskbar d. All of above

73. A small part of taskbar that has icons of background running applications is

a. Start button b. Quick launch

c. Task bar d. System tray

76. The date and time displays on

a. Taskbar b. Status bar

c. System tray d. Launch pad

81. The ....contains commands associated with the My Computer window

a. Standard menu b. Start menu

c. System menu d. None of the above
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82. .... is the layer of a computer system between the hardware and the user program

a. Operating environment

b. Operating system

c. System environment

d. None of these

85. The operating system is the most common type of .... Software

a. Communication b. Application

c. System d. Word processing software

86. Which of the following is/are external commands?

a. Edit b. Label

c. Sys d. All of above

87. Which is not an external command?

a. Edit b. XCOPY

c. Sys d. None of the above

95. Taskbar is used for

a. Navigation program

b. Switching between program

c. Start a program

d. All of above

98. Underlined text, such as text and folder names is referred to as

a. Hyperlink b. Menu

c. Source drive d. None of these

99. Which of the following is suitable after you install new drivers?

a. Shut Down b. Restart

c. Sleep d. Hibernate

100. Windows displays various options to shutdown. Which is suitable at the end of day?

a. Shut Down b. Restart

c. Sleep d. Hibernate

101. Which of the following shutdown method is often called Warm Boot?

a. Shut Down b. Restart

c. Sleep d. Hibernate

102. ______ is most often done after fixing a problem, adding a new program or making configuration

change

a. Shut Down b. Restart

c. Sleep d. Hibernate

106. Running multiple programs at the same time is called:

a. Multitasking b. Foreground tasking

c. Single tasking d. Symmetric

108. The function of Dir/W is

a. Show all details of file

b. Show only file name and directory name

c. Shows only directory

d. All of the above

110. What do you mean by dialog box?

a. Interactive message box

b. Group of options

c. Set of controls

d. All of the above

113. Which is not a system tool?

a. Folder b. Backup

c. Scandisk d. Format
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115. To change the volume label

a. Vol b. Label

c. Scandisk d. None

129. RD command are used to

a. Remove an empty directory

b. Remove non empty directory

c. Remove directory including files

d. None of the above

130. When you open my computer on desktop you see the information of

a. Hard disk b. CD

c. Removable disk d. All of the above

131. ....is an intermediate storage for deleted files

a. My computer b. My documents

c. Recycle bin d. None of above

136. What you type at the DOS command prompt to return back to windows?

a. Command b. Exit

c. Quit d. Return

139. Save operation means

a. Put data into processor

b. Put data into internal memory

c. Put data into secondary storage

d. Put data into monitor

168. Which of the following is not a mode in starting Windows?

a. Command Prompt b. Safe Mode

c. Normal Mode d. Turbo Mode

171. What is the full form of NTFS

a. New Technology File System

b. New Technical File System

c. New Technician File System

d. None of the above

172. Which one of the following is not the function of Operating System?

a. Resource Management

b. File Management

c. Networking

d. Processor Management

174. The following applications may appear on system tray except

a. System Clock

b. Volume Control

c. Network Connection

d. MS Office Suite

176. Which of the following is default location of saving and opening file?

a. Desktop b. My computer

c. My documents d. All of above

193. Which button might you find in a windows title bar?

a. Close button b. Maximize button

c. Minimize button d. All of the above

194. Press the ....button to have the window fill the entire screen

a. Close b. Maximize

c. Minimize d. none of the above
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196. ... are list of commands that appear on the screen

a. GUIS b. Icons

c. Menus d. Windows

200. To make file in MS Dos we need command

a. Copy b. Copy con

c. MD d. Make File

203. What is the function of an operating system?

a. Manages computer’s resources very efficiently

b. Takes care of scheduling jobs for execution

c. Manages the flow of data and instructions

d. All of the above

204. The Primary job of the operating system is

a. Manage Commands

b. Manage Users

c. Manage Programs

d. Manage Resources

205. Which of the following is not an operating system?

a. Windows 2000 b. Linux

c. Mac OS d. Notepad

211. A ....is a pointing device

a. Monitor b. Mouse

c. Keyboard d. None of these

213. Directory is similar to ....

a. File b. Folder

c. Item d. None of above

218. BIOS is used by

a. Operating system b. Compiler

c. Interpreter d. Application software
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Choose the correct answer:

1. What is the default number of lines to drop for drop cap

a) 3 b) 10

c) 15 d) 20

2. Which of the following methods will not enter data in a cell?

a) Pressing the Esc key b) Pressing an arrow key

c) Pressing the tab key d) Clicking the enter button to the formula bar

3. How many ways you can save a document?

a) 3 b) 4

c) 5 d) 6

4. Which of the following section does not exist in a slide layout?

a) Titles b) Lists

c) Charts d) Animations

5. Single spacing in MS-WORD document causes ____ point line spacing?

a) 10 b) 12

c) 14 d) 16

6. Which function will you use to enter current time in a worksheet cell?

a) =today() b) =now()

c) =time() d) =currentTime()

7. How many columns can you insert in a word document in maximum?

a) 35 b) 45

c) 55 d) 65

8. What PowerPoint feature will you use to apply motion effects to different objects of a slide?

a) Slide Transition b) Slide Design

c) Custom Animation d) Transition Speed

9. In a document what is the maximum number of columns that can be inserted in MS Word

Table?

a) 35 b) 15

c) 63 d) 65

10. When all the numbers between 0 and 100 in a range should be displayed in Red Color, apply

a) Use =if() function to format the required numbers red

b) Apply Conditional Formatting command on Home menu

c) Select the cells that contain number between 0 and 100 then click Red color on Text Color

d) All of above

11. To preview a motion path effect using the custom animation task pane, you should

a) click the play button b) click the show effect button

c) double click the motion path d) all of above

12. What is the maximum font size you can apply for any character

a) 163 b) 1638

c) 16038 d) None of above
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13. Word, by default, places a tab stop at every ___ mark on the ruler.

a) .25" b) .5"

c) .75" d) 1"

14. What is entered by the function =today()

a) The date value for the day according to system clock

b) The time value according to system clock

c) Today’s date as Text format

d) All of above

15. How much space in minimum must be provided between columns?

a) 0" b) 0.5"

c) 1" d) 1.5"

16. Word is preset to use standard 8.5-by-11-inch paper with _____ margins.

a) 1-inch left, right, top, and bottom

b) 1.25-inch left, right, top, and bottom

c) 1.25-inch left and right margins and 1-inch top and bottom

d) 1-inch left and right margins and 1.25-inch top and bottom

17. Which of the following is not a valid Zoom percentage in Excel?

a) 25 b) 200

c) 75 d) 125

18. What is the smallest and largest font size available in Font Size tool on formatting toolbar?

a) 8 and 72 b) 8 and 64

c) 12 and 72 d) None of above

19. What is the default font size of a new Word document based on Normal template in Word

2007?

a) 11 pt b) 12 pt

c) 14 pt d) None of above

20. Special effects used to introduce slides in a presentation are called

a) effects b) custom animations

c) transitions d) present animations

21. The minimum number of rows and columns in MS Word document is

a) 1 and 1 b) 2 and 1

c) 2 and 2 d) None of above

22. How will MS Word will respond in repeated word.

a) A Red wavy line under the repeated word

b) A Green wavy line under the repeated word

c) A Blue wavy line under the repeated word

d) None of the above

23. Formatting a cell in Currency, you can specify

a) Decimal Places b) Currency Symbol

c) Both of above d) None of above
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24. What is a Document Outline View?

a) A preview in a full screen

b) A preview with margins

c) A View with a margins and gutter

d) A view with a structure of heading at various levels

25. Ctrl + Z

a) Undo the last Action b) Redo the last Action

c) Add the new page d) Paste the contents from clipboard

26. The cell reference for cell range of G2 to M12 is _______

a) G2.M12 b) G2;M12

c) G2:M12 d) G2-M12

27. What does Ctrl + = key effect?

a) Superscript b) Subscript

c) All Caps d) Shadow

28. To select one hyperlink after another during a slide presentation, what do you press?

a) Tab b) Ctrl + K

c) Ctrl + h d) All of above

29. How can you make the selected character superscripted

a) Ctrl + = b) Ctrl + Shift + =

c) Alt + Ctrl + Shift + = d) None of above

30. When typing in a word field manually, what must you press to insert the code’s braces?

a) Ctrl + F6 b) Ctrl + F9

c) Alt + F11 d) Shift + F12

31. What is the short cut key to open the Open dialog box?

a) F12 b) Shift F12

c) Alt + F12 d) Ctrl + F12

32. What is the shortcut key to split a table?

a) Ctrl + Alt + Enter b) Ctrl + Shift + Enter

c) Alt + Shift + Enter d) Alt + Space + Enter

33. How many different documents you can open at one time?

a) No more than three

b) Only one

c) As many as your computer memory will hold

d) As many as your taskbar can display

34. Tabs stop position cannot be the following alignment

a) Decimal Alignment b) Center Alignment

c) Bar Alignment d) Justify Alignment

35. Which of the following is not an underline option in the format cells dialog box?

a) Double b) Single Accounting

c) Double Accounting d) Single Engineering
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36. Ctrl + B

a) Search the selected text b) Paste the selected text

c) Bold the selected text d) Open the specified file

37. After typing header text, how can you quickly enter footer text?

a) Press PageDown key and type the text for footer

b) Click on Switch between Heeder & Footer then type the text

c) Both (a) & (b) d) None of above

38. To move the cursor page to page of document

a) Ctrl+PgDn b) Ctrl+PgUp

c) Both (a) & (b) d) None of above

39. In order to edit a chart, you can

a) Triple click the chart object b) Click and drag the chart object

c) Double click the chart object d) Click the chart object

40. You can jump to the next column by

a) Clicking with your mouse on the next column

b) Press Alt + Down-arrow

c) Both (a) & (b) d) None of Above

1. Which of the following enables you to paste data multiple times?

a) History menu b) Office Clipboard

c) Both (a) & (b) d) None of the above

2. How can you increase the font size of selected text by one point every time?

a) By pressing Ctrl + ] b) By pressing Ctrl + [

c) By pressing Ctrl + } d) By pressing Ctrl + {

3. What is the default font used in MS Word 2007 document?

a) Times New Roman b) Arial

c) Calibri d) Preeti

4. In the context of animations, what is a trigger?

a) An action button that advances to the next slide

b) An item on the slide that performs an action when clicked

c) The name of a motion path

d) All of above

5. Word includes a series of predefined graphics called _____ that can be inserted into a Word

document.

a) clip art b) hyperlinks

c) captions d) bookmarks

6. A (n) _____is a dot or other symbol positioned at the beginning of a paragraph.

a) bullet b) logo

c) cell d) target
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7. Which of the following is not a type of page margin?

a) Left b) Right

c) Center d) Top

8. What is the short cut key to replace a data with another in sheet?

a) Ctrl + R b) Ctrl + Shift + R

c) Ctrl + H d) Ctrl + F

9. Which tab is not available on left panel when you open a presentation?

a) Outline b) Slides

c) Notes d) All of above are available

10. Which of the following is not on Home ribbon?

a) Columns b) Font color

c) Change Style d) Font

11. Ctrl + E

a) Exit Application b) Select All

c) Export d) Align Center

12. The selected design can be applied

a) to current slide only b) to all the slides

c) to all the new presentation you create d) all of above

13. A function inside another function is called _______

a) Nested function b) Round function

c) Sum function d) Text function

14. What is the shortcut key you can press to create a copyright symbol?

a) Alt+Ctrl+C b) Alt + C

c) Ctrl + C d) Ctrl + Shift + C

15. What is the short cut key to open Font dialog box?

a) Ctrl + F b) Alt + Ctrl + F

c) Ctrl + D d) Ctrl + Shift + D

16. From which menu you can access Picture, Test Box, Chart etc?

a) File b) Edit

c) Insert d) View

17. What is the shortcut key for Spelling Check in document?

a) F7 b) Shift + F7

c) Ctrl + F7 d) Alt + F7

18. What is the keyboard shortcut for creating a chart from the selected cell range?

a) F2 b) F4

c) F8 d) F11
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19. _____ are types of changes that occur when text has been omitted from a document and must

be inserted later.

a) Copy b) Paste

c) Cut d) Paste Special

20. In Word, the mailing list is known as the ____________.

a) data sheet b) source

c) data source d) sheet

21. Formulas in Excel start with

a) % b) =

c) + d) –

22. What is the shortcut key to Update Formula in a table?

a) F9 b) Alt + F9

c) Ctrl + F9 d) Shift + F9

23. On the horizontal ruler, an upside down T indicates a ____ tab stop.

a) left-aligned b) right-aligned

c) decimal-aligned d) centered

24. Ctrl + Y

a) Undo the last Action b) Repeat the last Action

c) Delete the last page d) Delete the first page

25. The Software which contains rows and columns is called ______

a) Database b) Drawing

c) Spreadsheet d) Word processing

26. What is a motion path?

a) A type of animation entrance effect

b) A method of advancing slides

c) A method of moving items on a slide

d) All of the above

27. “Ctrl + Delete” is used to

a) Delete the word just after the cursor

b) Delete the word just before the cursor

c) Delete the single letter just after the cursor

d) Delete the single letter just before the cursor

28. Which of the following is graphics solution for Word Processors?

a) Clipart b) WordArt

c) Drop Cap d) All of above

29. Which of the following format you can decide to apply or not in AutoFormat dialog box?

a) Number format b) Border format

c) Font format d) All of above
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30. Which short cut key inserts a new slide in current presentation?

a) Ctrl+N b) Ctrl+M

c) Ctrl+S d) All of above

31. Select a ______ to apply a predefined format to a Word 2007 table

a) Table style b) Table format

c) Format Style d) None of above

32. Which of the following is Page Orientation?

a) Landscape b) Portrait

c) Gutter d) Both A & B

33. To advance rightward from one cell to the next in a table, press the _____ key.

a) tab b) backspace

c) home d) enter

34. What is the use of “All Caps” feature in MS-Word?

a) It changes all selected text into Capital Letter

b) It adds captions for selected Image

c) It shows all the image captions

d) None of the above

35. To insert slide numbers

a) Insert a text box and select Insert >> Page Number

b) Insert a textbox and select Insert >> Number >> PageNumber

c) Choose Insert >> Slide Number

d) Insert a new text box and select Insert >> slide Number

36. Which of the following font effect is not available in PowerPoint Font dialog box?

a) Underline b) Shadow

c) Emboss d) Strikethrough

37. Which corner of the Word window has the zoom control?

a) upper-left b) upper-right

c) lower-left d) lower-right

38. Which of the following is not true about Find and Replace in Excel?

a) You can search for bold and replace with italics

b) You can decide whether to look for the whole word or not

c) You can search in formula too

d) You can search by rows or columns or sheets

39. When you point to the _____ corner of a table, the table move handle appears.

a) upper-right b) lower-left

c) lower-right d) upper-left

40. You can check the conditions against _________ when applying conditional formatting.

a) Cell value b) Formula

c) Both of above d) None of above
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1. What is gutter margin?

a. Margin that is added to the left margin when printing

b. Margin that is added to right margin when printing

c. Margin that is added to the binding side of page when printing

d. Margin that is added to the outside of the page when printing

2. When you delete a text box object from a slide in PowerPoint Presentation

a) The object is deleted but text box and the text inside is left on the slide

b) The text box is deleted and the text is pasted on the slide

c) The text box and text both are deleted

d) None of above

3. To start slide show of a presentation

a) Hit F5 key

b) From Slide Show menu choose View Show option

c) From Slide Show menu choose Rehearse timing

d) both a & b

4. The short cut key Ctrl + R is used in Excel to

a) Right align the content of cell

b) Remove the cell contents of selected cells

c) Fill the selection with active cells to the right

d) None of above

5. In slide layout panel how many layouts are available for text layout by default?

a) 4 b) 7

c) 9 d) 5

6. By default, on which page the header or the footer is printed?

a) on first page b) on alternate page

c) on every page d) none of the above

7. Ctrl + D shortcut key in Excel will

a) Open the font dialog box

b) Apply double underline for the active cell

c) Fill down in the selection

d) None of above

8. To open Power Point from Run Dialog Box, type ________

a) PowerPoint b) Pwrpoint

c) Powerpnt d) Powerpint

9. Where can you find the horizontal split bar on MS Word screen?

a) On the left of horizontal scroll bar

b) On the right of horizontal scroll bar

c) On the top of vertical scroll bar

d) On the bottom of vertical scroll bar
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10. Which of the following is not a font style?

a) Bold b) Italics

c) Regular d) Superscript

11. If you need a text to show vertically in a cell. How will you achieve this?

a) Choose Vertical on Text alignment in Format Cells dialog box

b) Choose 90 Degrees in Orientation of Format Cells dialog box

c) Choose Distributed from the Vertical drop down list of Format Cells dialog box

d) Choose Center Across Selection from Horizontal combo box in Format Cells dialog box

12. How you can stop the slide show.

a) Pressing Delete button. b) Pressing Esc button.

c) Pressing Right arrow. d) Pressing Left arrow.

13. Which of these data types is not in MS.excel?

a) Number b) Currency

c) Label d) Date/Time

14. The space left between the margin and the start of a paragraph is called

a) Spacing b) Gutter

c) Indentation d) Alignment

15. Which file formats can add to power point shows?

a) WAV b) JPG

c) MPEG d) All of these

16. The Pre-defined style that can be used for presentation in Power Point is called-

a) Auto style b) Wizard

c) Templates d) Pre Formatting

17. In which view Headers and Footers are visible

a) Normal View b) Page Layout View

c) Print Layout View d) Draft View

18. The process of removing unwanted part of an image is called

a) Hiding b) Bordering

c) Cropping d) Cutting

19. A spreadsheet is a collection of pages is called a _______

a) Workbook b) Art book

c) Worksheet d) Document

20. Text-styling feature of MS word is

a) WordColor b) WordFont

c) WordArt d) WordFill

21. The slide sorter in the power point is in the ________ menu.

a) Insert b) View

c) File d) Edit
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22. Which option of Chart Wizard contains the option of Series Name, Category and Value in

Data?

a) Legend b) Chart area

c) Data label d) Data Titles

23. The page to create Presentation in Power Point is called _____.

a) Sheet b) Paper

c) Slide d) Document

24. Which sign display when Formula Error in MS Excel

a) $ b) *

c) \ d) #

25. When using the Function, which reference operator is used to give the range?

a) ; b) &

c): d) =

26. Which items are placed at the end of a document

a) Footer b) Foot Note

c) End Note d) Header

27. To change line height to 1.5 we use shortcut key :

a) Ctrl+1 b) Ctrl + 2

c) Ctrl + 3 d) Ctrl + 5

28. A number of letter that appears little above the normal text is called :

a) Superscript b) Subscript

c) Supertext d) Toptext

29. What is the shortcut key to insert current date in cell ?

a) Ctrl +; b) Ctrl + T

c) Ctrl + D d) Ctrl + /

30. A number of letter that appears little below the normal text is called :

a) Superscript b b) Subscript

c) Supertext d) Toptext

31. We can insert a page number at

a) Header b) Footer

c) Both A and B d) None.

32. Which of these slides is used as a background.

a) Gradient b) Texture

c) Picture d) All of these

33. Which one can be used as watermark in a word document

a) Text b) Image

c) Both A and B d) None
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34. Which item appears dimly behind the main body text

a) Water Color b) Background

c) Watermark d) Back Color

35. In MS Excel cell, values 29, 19, 27, 39 and 20 are written from A6 to A11. Then what will be

the value of = MAX (A6: A11)?

a) 29 b) 39

c) 21 d) 20

36. Which feature starts a new line whenever a word or sentence reached a border

a) Text Line b) New Line

c) Text Wrapping d) Text Align

37. The direction of a rectangular page for viewing and printing is called

a) Orientation b) Direction

c) Print Layout d) Preview

38. What is the shortcut key to insert a new sheet in the current workbook?

a) F11 b) Ctrl + F11

c) Shift + F11 d) Alt + F11

39. We can remove / hide border of a shape by selecting …

a) No Line b) No Outline

c) White Line d) No Border

40. What is the shortcut key to create new Presentation in PowerPoint presentation.

a) Ctrl + N b) Ctrl + S

c) Ctrl + M d) Shift + N

1. Which chart would be useful to compare the sales price of two different branches of a dis-

tributor?

a) Scatter Chart b) Bar Chart

c) Doughnut Chart d) Area Chart

2. We can change the thickness of a line from ___

a) Line width b) Line Height

c) Line Thick d) Line Style

3. What item contains detailed information about something in the text?

a) Footer b) Foot Note

c) Header d) Head Note

4. Which item is printed at the bootom of each page

a) Header b) Foot Note

c) Title d) Footer

5. How is the data organize in the spreadsheet?

a) Line and Spacing b) Rows and Columns

c) Layers and Pallets d) Height and Width



M I T  C o m p u t e r  C e n t r e 15/12

O f f i c e  A u t o m a t i o n  S o f t w a r e  ( D C A - 1 0 3 )

6. Which orientation is set in the default page setup in the power point.

a) Landscape b) Portrait

c) Vertical d) None of these

7. Color and pattern used to fill a closed shape is called

a) Shape b) WordArt

c) Fill Style d) Fill Back

8. Where footnotes appear in a document

a) End of document b) Bottom of a Page

c) End of Heading d) None

9. Where does the active cell’s contents display in Excel?

a) Name Box b) Row Headings

c) Formula Bar d) Task Pane

10. How the chart is inserted in PowerPoint ?

a) Edit -> Chart b) Insert -> Pictures -> Chart

c) Insert -> Chart d) View -> Chart

11. The spelling and grammar tool

a) Indicates grammatical errors

b) Corrects spelling errors as you type

c) Identifies words with capitalization problems

d) All of above

12. You can replace the text

a) Ctrl+H b) Ctrl+R

c) Replace from Edit menu d) Both a & b

13. The insertion point

a) Provides features for changing margins, tabs, an indentations

b) Indicated the location where text line when necessary

c) Is located under the standard toolbar and has shortcut buttons

d) Is located under the standard toolbar and shortcut buttons

14. The cell address in the Microsoft Office Excel document is ____

a) Column Name b) First Row then Column Name

c) Row Name d) First Column then Row Name

15. When you want to view different parts of a document without moving the insertion point.

a) Use the previous page or next page buttons

b) Use the keyboard

c) Use the vertical and horizontal scroll bars

d Use the zoom button

16. You can add a date to a document by

a) Inserting a text date

b) Inserting a date field that will update automatically

c) Typing the date manually

d) All of the above
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17. Which of the following is not true regarding Conditional Formatting?

a) You can add more than one condition to check

b) You can set condition to look for Bold and apply Italics on them.

c) You can apply Font, border and pattern formats that meets the specified conditions

d) You can delete any condition from Conditional Formatting dialog box if it is not required

18. How many slides can be printed on the same page by using the handout.

a) 1 b) 6

c) 9 d) All of these

19. Right clicking on something in word

a) Delete the object

b) Nothing the right mouse button is there for left handed people

c) Opens the short-cut list

d) Insert the picture

20. Which key or key combination will move the insertion point to the bottom of your document?

a) Ctrl+End b) PageDown

c) Ctrl+Home d) End

21. To cut or copy text you must first

a) Click the remove/duplicate button

b) First highlight the text and click the Copy or Cut command from edit menu

c) Click on File menu

d) None of above

22. How many items can you copy to the Office Clipboard

a) 24 b) 20

c) 12 d) 10

23. The shortcut key to add Hyperlink in Worksheet is _______

a) Alt + K b) Ctrl + H

c) Ctrl + K d) Shift + Ctrl + K

24. The common point of row and column is called

a) pixel b) cell

c) 0 d) Track

25. The default page orientation of word document is

a) Landscape b) Portrait

c) Long sides d) Double long side

26. The thesaurus tool

a) Finds repeated words in document

b) Check for synonyms and antonyms

c) Identifies words with capitalization problems

d) All of the above

27. Which of the following is not option for changing the case of the text?

a) Indent case b) Sentence case

c) Toggle case d) Lower case
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28. How many types of layouts are in the power point

a) 4 b) 5

c) 9 d) None of these

29. The address of the current cell in Excel is displayed in _______

a) Formula bar b) Status bar

c) Name Box d) Title bar

30. What is the shortcut to open the dialog box of Format cell?

a) Alt + 1 b) Ctrl + 1

c) Ctrl + Shift + 1 d) None of these

31. To close the active documents, you can press

a) Ctrl+W b) Ctrl+C

c) Ctrl+Shift+C d) All of above

32. The clipboard is a
a) Feature that automatically adds or deletes space when you paste text

b) Used to temporarily store items that have been cut or copied

c) A reserved place in the memory of the computer

d) Located below the status bar

33. Superscript, subscript, outline, emboss, engrave are known as

a) font styles b) font effects

c) word art d) text effects

34. If you want a blank line after the title in the worksheet, which of these methods will be the

best?

a) Re-Format the spreadsheet b) Insert the Row

b) Increase the column Width d) Use the Space bar

35. To show the range of cells, we use …………. in excel

a) Semicolon b) Comma

c) Colon d) Dot

36. Bold, Italic, Regular are known as

a) font styles b) font effects

c) word art d) text effects

37. In MS-Word, for what does ruler help?

a) to set tabs b) to set indents

c) to change page margins d) All of the above

38. Which of these is not the view of PowerPoint?

a) Slide Show view b) Slide Sorter view

c) Normal view d) Outline view

39. Borders can be applied to

a) cells b) paragraph

c) text d) All of above
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40. You can auto fit the width of column by

a) double clicking on the column name on column header

b) Double click on the cell pointer in worksheet

c) Double clicking on column right border on column header

d) Double clicking on the column left border of column header



System Analysis and Design/Documents On Web           Multiple Choice Questions 

11.1 Internet is 

a. a local computer network 

b. a world wide network of computers 

c. an interconnected network of computers 

d. a world wide interconnected network of computers which use a common 

protocol to communicate with one another 

11.2 The facilities available in the internet are 

                                 (i) electronic mail 

                                             (ii) remote login 

                                             (iii)file transfer 

                                       (iv)word processing 

a. i, ii  

b. i, ii, iii 

c. i, ii, iv 

d. ii, iii and iv 

11.3 Internet requires 

a. an international agreement to connect computers 

b. a local area network 

c.  a commonly agreed set of rules to communicate between computers 

d. a World Wide Web 

11.4 Each computer connected to the internet must 

a. be an IBM PC 

b. have a unique IP address 

c. be internet compatible 

d. have a modem connection 

11.5 IP address is currently 

a. 4 bytes long 
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b. available in plenty 

c. 6 bytes long 

d. not assigned as it is all used up 

11.6 IP addresses are converted to 

a. a binary string 

b. alphanumeric string 

c. a hierarchy of domain names 

d. a hexadecimal string 

11.7 Internet addresses must always have at least 

                       (i) a country name or organization type 

                                    (ii) internet service provider’s name 

                                    (iii) name of organization 

                                    (iv) name of individual 

                                     (v) type of organization 

a. i, ii, iii  

b. ii, iii, iv 

c. i, iii  

d. ii, iii, iv, v 

11.8 Internet uses 

a. Packet switching 

b. Circuit switching 

c. Telephone switching 

d. Telex switching 

11.9 Internet data is broken up as 

a. fixed length packets 

b. variable length packets 

c. not packetized 
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d. 64 bytes packets 

11.10 Internet  packet  data  structure  consists of 

                             (i)source address 

                                          (ii) destination address 

                                           (iii)serial number of packets 

                                           (iv)message bytes 

                                           (v)Control bits for error checking 

                                     (vi) Path identification bits 

a. i, ii, iii  

b. i, ii, iii, iv 

c. i, ii, iii, iv, v  

d. i, ii, iii, iv, v, vi 

11.11 The packets of an internet message 

a. take a predetermined path 

b. take a path based on packet priority 

c. go along different paths based on path availability 

d. take the shortest path from source to destination 

11.12 The time taken by internet packets 

a. can be predetermined before transmission 

b. may be different for different packets 

c. is irrelevant for audio packets 

11.13 By an intranet we mean 

a. a LAN of an organization 

b. a Wide Area Network connecting all branches of an organization 

c. a corporate computer network 

d. a network connecting all computers of an organization and using the internet 

protocol 
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11.14 By an extranet we mean 

a. an extra fast computer network 

b.  the intranets of two co-operating organizations interconnected via a secure 

leased line 

c.  an extra network used by an organization for higher reliability 

d. an extra connection to internet provided to co-operating organizati 

11.15 World Wide Web 

a. is another name for internet 

b. world wide connection for computers 

c.  a collection of linked information residing on computers connected by the 

internet 

d. a collection of world wide information 

11.16 Among services available on the World Wide Web are 

                                  (i)Encryption 

                                               (ii)HTTP 

                                                (iii)HTML 

                                          (iv)Firewalls 

a. i and ii  

b. ii and iii 

c. iii and iv  

d. i and iv 

11.17 A world wide web contains web pages 

a. residing in many computers 

b. created using HTML 

c. with links to other web pages 

d. residing in many computers linked together using HTML 

11.18 A web page is located using a 
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a. Universal Record Linking 

b. Uniform Resource Locator 

c. Universal Record Locator 

d. Uniformly Reachable Links 

11.19 A URL  specifies  the  following: 

                                  (i) protocol used 

                                              (ii) domain name of server hosting web page 

                                              (iii) name of folder with required information 

                                               (iv) name of document formatted using HTML 

                                          (v) the name of ISP 

a. i, ii, iii, iv  

b. ii, iii, iv, v 

c. i, iii, iv  

d. i, ii, iii, v 

11.20 A search engine is a program to search 

a. for information 

b. web pages 

c. web pages for specified index terms 

d. web pages for information using specified search terms 

11.21 HTML stands for 

a. Hyper Text Making Links 

b. Hyper Text Markup Language 

c. Higher Textual Marking of Links 

d. Hyper Text Mixer of Links 

11.22 HTML is similar to a 

a. word processing language 

b. screen editor 
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c. scripting language 

d. search engine 

11.23  Desirable  properties  of a  website  are 

                                 (i)a meaningful address 

                                             (ii)Help and search facilities 

                                             (iii) Links to related sites 

                                             (iv)Features to allow users to give feedback 

                                       (v)Hosting on a mainframe 

a. i, ii, iii  

b. i, ii, iii, iv 

c. i, ii, iii, iv, v  

d. i, ii, iii, v 

11.24 HTML uses 

a. pre-specified tags 

b. user defined tags 

c. tags only for linking 

d. fixed tags defined by the language 

11.25 HTML tags define 

a. The data types of elements of document 

b. Presentation of specified elements of a document 

c. The contents of the document 

d. The structure of the document 

11.26 The tag used in HTML to link it with other URL’s is: 

a. <A> 

b. <H> 

c. <U> 

d. <L> 
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11.27 The tags   used  for  specifying  fonts in HTML are 

                              (i)   <B> 

                             (ii)   <I> 

                             (iii)  <U> 

                             (iv) <L> 

a.   (i) and (ii)                  

b.   (i) and (iii) 

c.   (ii) and (iv)                          

d.   (i),(ii) and (iii) 

11.28  It is possible to display pictures (i.e, images) in HTML specification by 

        using     the     tag.       

a. <GR src = Picture file> 

b. <PIC src =Picture file> 

c. <IMG src =Picture file> 

d. <GIF src=Picture file 

11.29 SGML stands for 

a. Standard Generalized Markup Language 

b. Structured General Markup Language 

c. Standard Graphics Mapping Language 

d. Standard General Markup Link 

11.30   HTML and XML are markup languages 

a. Specially development for the web 

b. Are based on  SGML 

c. Are versions of SGML 

 

V. Rajaraman/IISc. Bangalore  M11/V1/July 04/7 



System Analysis and Design/Documents On Web           Multiple Choice Questions 

d. Independent  of SGML    

11.31  XML stands for 

a. Extra Markup Language 

b. Excellent Markup Links 

c. Extended Markup Language 

d. Extended Marking Links 

11.32  XML uses 

a. user define tags 

b. pre-defined tags 

c. both predefined and user-defined tags 

d. Extended tags used in HTML and makes them powerful 

11.33   In order to interpret XML documents one should 

a. Use standardized tags 

b. Have a document type definition which defines the tags 

c. Define the tags separately 

d. Specify tag filename 

11.34 The  advantages  of XML  over HTML are 

                         (i)   It allows processing of data stored in web-pages 

                    (ii) It uses meaningful tags which aids in understanding the nature 

                                of a document 

                          (iii)Is simpler than HTML 

                          (iv)It separates presentation and structure of document 

a.  (i),(ii) and (iii)  

b.  (i),(ii) and(iv) 

c.  (ii),(iii) and (iv)  

d.  (i),(iii) and (iv) 

11.35  XSL definition is used along with XML definition to specify  
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a. The data types of the contents of XML document 

b. The presentation of XML document 

c. The links with other documents 

d. The structure of XML document 

11.36  XLL definition is used along with XML to specify 

a. The data types of the contents of XML document 

b. The presentation of XML document 

c. The links with other documents 

d. The structure of XML document 

11.37 DTD definition is used along with XML to specify 

a. The data types of the contents of XML document 

b. The presentation of XML document 

c. The links with other documents 

d. The structure of XML document 
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Key to Objective Questions 

11.1    d 11.2   b 11.3   c       11.4    b 11.5   a    11.6    c 

11.7    c 11.8   a 11.9   b      11.10   c      11.11  c     11.12  c 

11.13 d           11.14   b        11.15 c      11.16   b     11.17   d    11.18   b 

11.19 a            11.20  d        11.21    b      11.22    a     11.23     b   11.24    d  

11.25    b        11.26    a        11.27    a      11.28     c     11.29    a    11.30  b 

11.31  c         11.32  a        11.33  b      11.34   b     11.35  b   11.36   c 

11.37  a 
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Choose the correct answer:

1.For What work Photoshop is used ?

A) For Graphics B) For Animation

C) For Programming D) For Typing

2. Which company made Image Ready?

A) Adobe Systems B) Citrix Systems

C) Cisco Systems D) Microsoft

3. What is File Extension in Photoshop?

A) Bmp B) Tiff

C) Psd D) Txt

4. Which menu contains the duplicate layer option in Photoshop?

A) Image B) Layer

C) Filter D) Edit

5. Which of these software is using the Gradient tool?

A) Page maker B) Painting

C) Photoshop D) All of these

6. Full form of DPI-

A) Dots per inch B) Dots per ink

C) Disk Point Inch D) Display per inch

7. What is the full form of RGB ?

A) Red Green Black B) Red Gray Black

C) Red Green Blue D) Red Gray Blue

8. What is the meaning of CMYK?

A) Cream Magenta Yellow Kole B) Cyan Magenta Yellow Blue

C) Cyan Magenta Yellow Brown D) Cyan Magenta Yellow Black

9. Which of these formats supports Transparency?

A) Jpeg B) Png

C) Gif D) Jpg

10. The full form of GIF –

A) Graphics Interchange Format B) Graphics inter file

C) Gray-scale Interchange file D) Graphics Interchange file

11. In which of these formats does not change the image quality when the image is saved?

A) Tiff B) Jpeg

C) Png D) Gif

12. Which one of these formats is not an image format?

A) EPS B) PCX

C) WPG D) DPI
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13. What is the meaning of S in HSB color model ?

A) Color B) Saturation

C) Brightness D) All of these

14. Which color mode is used for printing?

A) RGB B) CMYK

C) Gray Scale D) BMP

15. Examples of Vector Image are-

A) EPS B) BMP

C) GIF D) JPG

16. What kind of colors are red, yellow and blue?

A) Primary B) Secondary

C) Tertiary D) Complementary

17. When did Photoshop start?

A) 1985 B) 1986

C) 1987 D) 1988

18. Photoshop launched by which company?

A) Adobe B) Aldus

C) EULA D) Microsoft

19. The images are made of ________

A) DPI B) Pixels

C) Drawing D) Pictures

20. By using which of these options, a new file is created in Photoshop

A) File > New B) File > Open

C) Create > New D) Start > New File

21. What is the shortcut key to create a duplicate layer of a layer?

A) Ctrl+J B) Ctrl+T

C) Ctrl+N D) Ctrl+D

22. What is the shortcut key to create a new file in Photoshop?

A) File, new B) Ctrl + N

C) Ctrl+Shift+N D) Shift+N

23. Which of these color models is not in Photoshop?

A) RGB B) LAB

C) CNYK D) HSB

24. Raster Image is also known as …………

A) Color Image B) Bitmap Image

C) Curve Image D) Graphic Image

25. What types of graphics are made of Pixels?

A) Raster Image B) Vector Graphics

C) A and B Both D) None of these
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26. ________ is a raster graphics editor (with significant vector graphics functionality).

A. Adobe Photoshop B. Adobe Photoshop Elements

C. Adobe Flash D. Adobe Illustrator

27. Who developed Adobe ImageReady?

A.  Adobe Systems B.  Citrix Systems

C.  Cisco Systems D.  Microsoft

28. Hitting which of the following keys will make palettes and the toolbox go away?

A. Control-X B. Tab

C. Shift-Tab D. D minor

29.The typical size for a graphic design is measured in __________.

(a)   pica (b)   pixels

(c)    points (d)    inches

30.To cut down the size of the entire graphic design, including all layers, you should select the

______ tool.

(a)   marquee (b)   magic wand

(c)    eraser (d)    crop

31.Twirl, ripple and spherize are examples of distortion __________ you may use to change the

look of your graphic.

(a)   filters (b)   blending options

(c)    image adjustments (d)    layer modes

32.Drop shadow, inner glow and bevel are examples of _________ you need to use with text.

(a)   filters (b)   blending options

(c)    image adjustments (d)    layer modes

33.The tool allows you to copy one area of the layer to another area of the layer.

(a)   magic wand (b)   clone stamp

(c)    marquee (d)    gradient

34.The _______ tool allows you to select a rectangular or circular area of an layer to change or

delete.

(a)   marquee (b)   crop

(c)    hand (d)    zoom

35.To delete a series of steps that have been used in a graphic design, you would need to use the

_________ pallette.

(a)   layer (b)   action

(c)    history (d)    path

36.To undo the last change made to your graphic design, the keys may be used.

(a)   Control + D (b)   Control + Z

(c)    Shift + D (d)    Shift + Z
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37.To turn-off the use of a tool, or deselect it, you must push the keys.

(a)   Control + Z (b)   Shift + Z

(c)    Control + D (d)    Shift + D

38.Pixels represent tiny ________ of color, which are typically unseen by the naked eye.

(a)   circles (b)   squares

(c)    inches (d)    swatches

39.The ________ tool is best selected when you need to select an abnormally shaped image in a

layer.

(a)   marquee (b)   lasso

(c)    magic wand (d)    clone stamp

40.The tool allows you the magnify an area of the design for detail work.

(a)   zoom (b)   filters

(c)    crop (d)    eraser

41.The tool allows you to cut text out of a scenic background for use in your design.

(a)   blending options (b)   image adjustments

(c)    layer modes (d)    text mask

42.Clouds, motion blur, ocean ripple and plastic wrap are all examples of that can be used in

your graphic design.

(a)   transparency (b)   opacity

(c)    filter (d)    zoom

43If you have a solid color to select and delete, the tool is the quickest and most effective.

(a)   magic wand (b)   color picker

(c)    zoom (d)    none

44.When deleting detailed areas of your image by hand, the tool is the best option.

(a)   magic wand (b)   clone stamp

(c)    gradient (d)    eraser

45.which tool allows you to reposition an object in your layer

(a)   move (b)   marquee

(c)    crop (d)    hand

46.The name of the areas that include the color swatches, layers and toolbox

(a)   layer (b)   layer effect

(c)    blending option (d)    pallette

47.The name of the area upon which the graphic design is completed is

(a)   gradient (b)   canvas

(c)   smudge (d)   stage

48.There are how many types of 2D graphics?

(a)   2 (b)   3

(c)    4 (d)    5
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49.Bitmap is sometimes referred as

(a)   JPEG (b)   GIF

(c)    Raster (d)    none

50.JPEG stands for?

(a)   Joint Photographic Experts Group (b)   Joint Photographic Exports Group

(c)    Join Photographic Experts Group (d)    none

51.GIF stands for?

(a)   Graphics interrelated format (b)   Graphics interchange formula

(c)    Graphics interchange format (d)    none

52.TIFF stands for?

(a)   Tagged Image File Formula (b)   Tougle Image File Format

(c)    Tagged Image File Format (d)    none

53.PNG stands for?

(a)   Portable Network Graphics (b)   Portable Network Grap

(c)    Port Network Graphics (d)    none

54. Which tool is used to move an image in Photoshop ?

A) Slice Tool B) Selection Tool

C) Direct Selection Tool D) Move Tool

55 Which tool is used to select a similar pixels

A) Lasso Tool B) Magic Tool

C) Magic Eraser Tool D) Clone Tool

56. Which tool is used to fill single color in background

A) Gradient Tool B) Paint Bucket Tool

C) Paint Bucket Tool D) Background Tool

57. Which tool is used to remove any spot in the image.

A) Eraser Tool B) Spot Brush Tool

C) Spot Healing Brush Tool D) Gradient Tool

58. Which tool is used to blur the image

A) Sharp B) Blur

C) Smudge D) Dodge

59. Which tool is used to make selection in the round shape.

A) Ellipse Tool B) Rectangle Tool

C) Circle Tool D) Pen Tool

60. Which tool is used to select any color from the image in Photoshop

A) Paint Bucket B) Eyedropper

C) Zoom D) Pen

61. With help of which tool the character is inserted in Photoshop

A) Slice Tool B) Type Tool

C) Pen Tool D) Pencil Tool
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62. Which key is pressed while using the Clone tool

A) Alt B) Ctrl

C) Shift D) Tab

63. What is called the change of the size of an image

A) Selection B) Transform

C) Modify D) Contract

64. Which tool is used to light the pixels of the image in Photoshop

A) Smudge B) Sharpen

C) Burn D) Dodge

65. Which of these palettes is not in Photoshop

A) Layer B) Navigator

C) Channel D) Drawing

66. What is the shortcut key to Zoom Out

A) Ctrl + / B) Ctrl + O

C) Ctrl + – D) Ctrl + F

67. Which of the following options is in FILTER

A) Blur B) Noise

C) Liquefy D) All of these

68. Which of these palettes is not displayed by default in Photoshop

A) History Palette B) Navigator Palette

C) Color Palette D) Layers Palette

69. Crop Tool is used-

A) To cut the image B) To move the image

C) To paint the image D) To select the image

70. Which key is used to remove the selection on the image

A) Ctrl+V B) Ctrl+C

C) Ctrl+D D) Ctrl+I

71. Which of these tools is not a selection tool

A) Lasso Tool B) Magic Wand Tool

C) Polygonal Lasso Tool D) Pen Tool

72. Which of these options is not available in Photoshop?

A) Drawing Toolbar B) Option Toolbar

C) Toolbox D) Palette

73. Which of these tools is called painting tools

A) Pencil Tool B) Gradient Tool

C) Brush Tool D) All of these
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74. In Photoshop, which palette contains important information such as image size, the tool

being used, etc.

A) Navigator Palette B) Layer Palette

C) Info Palette D) History Palette

75. In Photoshop, _________ allows objects to work on an image object without teasing any

other object

A) Palette B) Toolbox

C) Layers D) None of these

76. How to make New Layer in Photoshop

A) File>New B) Layer>New

C) Image>New D) Edit>New

77. Which of the following is not a menu in Photoshop?

A) Image B) Select

C) Filter D) Tools

78. To get Desaturate option in Photoshop, we have to go to

A) File Menu B) Layer Menu

C) Image>Adjustment D) None of the above

79. To get Auto contrast option in Photoshop, select

A) Filter Menu B) Image>Adjustment

C) File Menu D) None of the above

80. How many Color Modes are there in Photoshop?

A) Five B) One

C) Three D) None

81. How many types of Gradient are there in Photoshop?

A) Five B) Two

C) Six D) Three

82. How many type of Marquee Tool are there in Photoshop?

A) Seven B) One

C) Four D) Two

83. To get Auto contrast option in Photoshop, we have to select

A) Image --> Adjustment B) File Menu

C) Filter Menu D) None

84. How many type of Marquee Tool are there in Photoshop?

A) Seven B) One

C) Four D) Six

85. To get Stroke option in Photoshop, we have to select

A) Select Menu B) Filter Menu

C) Edit Menu D) None of the above
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86. Blurs edges by building a transition boundary between the selection and its surrounding

pixels is known as

A) Anti-aliasing B) Feathering

C) Healing D) None of the above

87. By default how many channel Indexed color images are there?

A) One Channel B) 255 Channel

C) 216 Channel D) 256 Channel

88. In Photoshop, maximum how many alpha channels can create in an image?

A) 20 B) 22

C) 24 D) 26

89. How many selection tools are there in Photoshop?

A) 8 B) 4

C) 9 D) 2

90. Which one lets you isolate and protect areas of an image as you apply color changes, filters or

other effects to the rest of the image?

A) Mask B) Image Matte

C) Opacity D) None of the above

91. Which command changes the Overall mixture of colors in an image for generalized color

correction?

A) The Color Balance B) Variations

C) Curves D) None of the above

92. We use Dodge Tool to ___________________ the area of image.

A) Lighten or darken B) Sharp or Unsharp

C) Blur and mix D) None of the above

93. To get Feather option in Photoshop.

A) Image>Adjustment B) Select Menu

C) Edit Menu D) None of the above

94. To get Desaturate option in Photoshop

A) File Menu B) Layer Menu

C) Image>Adjustment D) None of the above

95. To get Auto contrast option in Photoshop

A) Filter Menu B) Image>Adjustment

C) File Menu D) None of the above

96. How many Color Modes are there in Photoshop?

A) Five B) One

C) Four D) None

97. The default size of a web banner is___________x__________

A) 400 X 400 B) 72 X 72

C) 468 X 60 D) None of the above



M I T  C o m p u t e r  C e n t r e 11/9

C o m p u t e r  G r a p h i c s  ( D C A - 1 0 5 )

98. The Keyboard shortcut of swap foreground and background color is

A) S B) W

C) X D) None

99. The Keyboard shortcut default foreground and background color is

A) D B) F

C) C D) None

100. The Keyboard shortcut for layer option is

A) F7 B) F10

C) F1 D) None

101. The range of feather is

A) 0.2 - 255 B) 2 - 255

C) 0.2 - 256 D) None

102. The Keyboard shortcut to convert a shape to a selection is

A) Ctrl + Enter B) Alt + Enter

C) Ctrl + Shift + Enter D) None

103. We can change width or height or resolution of an image respective of other two at a time by

A) Selecting Resample Image option from image size

B) Deselecting Resample Image option from image size

C) Selecting Constrain Proportion option from image size

D) None

104. We can resize the canvas as per the size of an image by using

A) Crop option B) Trim option

C) Both of them D) None

105. The smallest part of a displayed bitmapped image is

A) Pixel B) Dot

C) Both of them. D) None

106. We can get Resize image option from

A) Help menu B) Image menu

C) Edit menu D) None

107. The keyboard shortcut of duplicate layer is

A) Ctrl+J B) Alt+J

C) Ctrl+Alt+J D) None

108. The keyboard shortcut to make a new layer is

A) Ctrl+Shift+N B) Ctrl+N

C) Alt+Shift+N D) None

109. -100 range of Contrast

A) Change the whole image to gray B) Remain the image same

C) Make the contrast high of an image D) None
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110. Image > Mode > 16 bit is activated, when

A) An image changed to Indexed mode

B) An image changed to CMYK mode

C) An image changed to RGB mode

D) None

111. We can change Color balance, Tone balance and Purity of color from

A) Image > Adjustment > Variation

B) Image > Adjustment > Color balance

C) Image > Mode > Multichannel

D) None

112. We can change the Photoshop canvas to Expert mode by

A) Pressing the F button two times B) Pressing the E button two times

C) By clicking Expert mode button D) None

113.  __________________ option give us the information of color etc. of an image.

A) Histogram B) Color balance

C) Variation D) None

114. ________________ means purity of color

A) Saturation B) Desaturation

C) Contrast D) None

115. For printing purpose, the resolution should be

A) 72 ppi B) Minimum 300 ppi

C) 72 - 100 ppi D) None

116. We can get "Export transparent Image" from

A) Help menu B) Window menu

C) Edit menu D) None

117. We can swap between the Lasso tools by

A) Shift+L B) Alt+L

C) Alt+Shift+L D) None

119. The keyboard shortcut of Brush option is

A) F5 B) Alt + 5

C) Ctrl + 5 D) None

120. We can change the color balance of an image with the help of another layer without distort-

ing the actual image through

A) Layer > New Adjustment Layer > Color balance

B) Layer > New layer > Color balance

C) Layer > Adjustment Layer > Color balance

D) None
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121. We can extract a part of an image without the help of any kind of Marquee or Lasso tool

A) Filter > Extract B) Select > Modify > Extract

C) Edit > Extract D) None of the above

121. In a Bitmap mode image, the shades are adjusted by changing the quantity of __________

and __________ dots

A) Black, White B) Gray, White

C) Gray, Black D) None of the above
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Choose the correct answer:

1. Shortcut Key of UNDO is –

A) Ctrl + X B) Ctrl + H

C) Ctrl + Y D) Ctrl + Z

2. What is the character to be shortened to its normal shape and display something below its location ?

A) Superscript B) Drop Cap

C) Subscript D) Alignment

3. What is the character displayed by showing it slightly above its normal size?

A) Superscript B) Drop Cap

C) Subscript D) Alignment

4. What is the full form of PDF?

A) Picture Document Format

B) Portable Document Format

C) Portable Direct Format

D) Pixel Document Format

5. Which page size paper is used in the laser printer?

A) A4 B) Letter

C) Legal D) All of these

6. The layout of the page depends on_____

A) On page size B) On Text

C) On Paragraph D) All of these

7. Which of these software can be a master page?

A) PageMaker B) Painting

C) Photoshop D) All of these

8. What is the extension of file created in PageMaker ?

A) Psd B) Pmd

C) Tiff D) Txt

9. Which company had developed PageMaker?

A) Microsoft

B) Adobe Corporation

C) Aldus Corporation

D) Intel

10. What is the unit to measure the quality of the picture?

A) DPI B) LPI

C) PPI D) CCD

11. Which menu contains the Find option in Pagemaker?

A) Edit B) Insert

C) Utilities D) View

12. When did Pagemaker begin?

A) 1980 B) 1985

C) 1990 D) 1995

13. How many columns are in the newspaper?

A) 10 B) 9

C) 8 D) 7

14. Which one of these is not size of paper ?

A) A1 B) A3

C) A5 D) A6

15. What is the first step of the page layout for desktop publishing –

A) Selecting Page Size

B) Selecting Page Border

C) Selecting the page margin

D) None of these

16. Which of these is not the main part of the PageMaker application ?

A) Title Bar B) Color Palette

C) Drawing Toolbar D) Control Palette
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17. Which of the following is not a menu in PageMaker ?

A) Elements B) Type

C) Utilities D) Format

18. Which of these tools is not in the toolbox-

A) Ellipse Tool B) Polygon Tool

C) Rotating Tool D) Move Tool

19. The Shortcut key of ZOOM OUT is –

A) Ctrl + + B) Ctrl + –

C) Ctrl + O D) Ctrl + Z

20. How many menus are there in PageMaker ?

A) 6 B) 7

C) 8 D) 9

21. SHIFT + F7 is the shortcut key of ______

A) Zoom Tool B) Hand Tool

C) Ellipse Tool D) Crop Tool

22. How many VIEWS are there in the PageMaker’s control palette?

A) 2 B) 3

C) 4 D) 5

23. Which option is used to import text on the page in Page Maker ?

A) Open B) New

C) Insert D) Place

24. Which of these is related to vertical alignment in Page Maker ?

A) Frames B) Page Setup

C) Table D) Picture

26. By using of which tool we can insert a picture in PageMaker?

A) Picture Palette B) Clip Art

C) Diagram Tool D) Insert Graphics

27. Which of the following is not palette in PageMaker?

A) Style Sheets B) Control

C) Colors D) Document Layout

28. What is the minimum font size in PageMaker?

A) 8 B) 7

C) 6 D) 4

29. Which of the following options can not be the style sheet?

A) Drop Cap B) Leading

C) Font Color D) Line End

30. Which option does the text flow in PageMaker?

A) Standard B) Auto Flow

C) Semi-Auto Flow D) All of the Above

1. Which of the following is not a palette in PageMaker?

a) Style Sheets b) Control

c) Colors d) Document Layout

2. If you press the [command] key while your pointer contains loaded text, what happens:

a) Nothing

b) The text is deleted

c) The pointer becomes an Standard pointer

d) The pointer becomes an Auto Flow pointer

3. The largest font size in PageMaker is:

a) 650 b) 72

c) 823 d) 1,200

4. The smallest font size in PageMaker is:

a) 8 b) 7

c) 6 d) 4

5. Which menu contains the Document Setup command

a) Edit b)File

c)View d)Document
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6. How many master pages can you have?

a) Unlimited b) 255

c) 172 d) 2

7. Which of the following can't be included in a style sheet

a) Drop Cap b) Leading

c) Font color d) Line end

8. What is Leading?

a) The space between paragraphs.

b) The space between two characters.

c) The space between more than two characters.

d) The space between lines.

9. If you wanted to "shuffle" or "reorder" your pages, you would use which PageMaker command?

a) Shuffle

b) Document Layout palette

c) Sort Pages

d) You can not shuffle pages in PageMaker

10. Which of the following are text flow options in PageMaker?

a) Standard b) AutoFlow

c) Semi-Auto Flow d) All of the above

11. Which feature could you use if the job is finished and you are ready to send it to your printer?

a) Collect for Output

b) Make Ready

c) Shrink, Zip and Go

d) Save for Service Provider

12. Pick  the kind of tab that PageMaker does not support:

a) Left b) Right

c) Decimal d) Flush

13. Which command is NOT found in the Utilities menu?

a) Book b) Define Colors

c) Define Styles d) Plug-ins

14. By default, graphics larger than ___ are stored in the PageMaker publication:

a) 1 MB b) 256 KB

c) 16 KB d) Files are never stored in the publication

15. What is the largest PageMaker publication you can have (in number of pages):

a) 9999 b)999

c)9 d)9.9

15 Which menu in Page Maker contains the zoom option?

a) file b)view

c)utilities d)none of these

16. Which menu of Page Maker contains the font option?

a) layout b) type

c) utilities d) element

17. In Page Maker which menu contains Frames option?

a) file b) utilities

c) element d) none of these

18. What is the extension of PageMaker file?

a) .cdr b) .pmd

c) .gif d) none of these

19. The name of the areas that include the color swatches, layers and toolbox is ……………

a) gradients b) colors

c) pallette d) all of these

20. What is optimization?

a) manage the size of image

b) act of managing colors

c) act of balancing the display quality of graphic

d) none of these
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31. Which menu contains the font option in PageMaker ?

A) Layout B) Type

C) Utilities D) Element

32. Which menu contains the frame option in PageMaker?

A) File B) Utilities

C) Element D) None of these

33. Which of these options is not in the PageMaker?

A) Toolbox B) Style and Color Palette

C) Control Palette D) Slide Palette

34. How many types of screen view in PageMaker?

A) 2 B) 3

C) 4 D) 5

35. Which of these views is not in the PageMaker?

A) Layout ViewB) Story Editor View

C) Outline View D) None of these

36. Which option is used to display master items on a page in PageMaker ?

A) Display Master Item

B) Show Master Item

C) View Master Item

D) Insert Master Items

37. Which option is used to change the order of pages in PageMaker ?

A) Page Orientation B) View Pages

C) Sort Pages D) Range Pages

38. Which menu contains Insert Pages option ?

A) File B) Layout

C) Element D) Utilities

39. What is the default font size in PageMaker ?

A) 11 B) 12

C) 13 D) 14

40. How many alignments are there in PageMaker ?

A) 3 B) 4

C) 5 D) 6

41. Which menu contains the Story Editor option ?

A) File B) Edit

C) View D) Insert

42. What are the shortcut to window fit in window in Pagemaker ?

A) Ctrl+0 B) Ctrl+1

C) Ctrl+2 D) Ctrl+3

43. Which menu contain the Show Master Page option in Pagemaker?

A) Layout B) Window

C) Element D) Utilities

44. Which of the options is not available in the Type Style in Pagemaker ?

A) Bold B) Italic

C) Strikethrough D) Indent

45. What is the shortcut key of Find ?

A) Ctrl + F B) Ctrl + H

C) Ctrl + Y D) Ctrl + Z

46. The default page size in PageMaker 6.5 is ________.

A A4 B Custom

C 210 X 297 mm. D Letter

47. Text Wrap can not be used in case of _______ graphics.

A Inline B Imported

C Both of the above D None of the Above

48. The shortcut key to select the arrow pointer tool is ____.

A Alt+F1 B Ctrl+Spacebar

C F9 D None of the above
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49. Indents and Tabs option provides _____ types of Tab.

A 3 B 5

C 4 D None of the above

50.In PageMaker, we can create the border automatically around the object, by using ________ option from

Utilities > Plug-ins.

A Border B Keyline

C Outline D None of the above

51. Paragraph Specification dialog box provides _____types of Alignment.

A 4 B 6

C 5 D None of the above

52. Short cut key of Style palette is ________ .

A Ctrl+8(eight) B Ctrl+B

C Shift+Ctrl+S D None of the above

53. The keyboard shortcut for Force Justify is ______ .

A Shift+Ctrl+Y B Ctrl+J

C Shft+Ctrl+F D None of the above

54. Change Case plug-ins provide ____ type of Case.

A 3 B 1

C 2 D 5

55. We get Autoflow option in ______ menu.

A Element B Layout

C Place D None of the above

56. There are ____ types of view in Control Palette.

A 1 B 2

C 3 D None of the above

57.We get "High Resolution" option from _____ dialog box.

A General B Prefarence

C Document Setup D Graphices

58. We can see Left / Right margin when _______ option is off.

A Facing Page B See Inside/Outside

C Double Sided D None of the above

59. We can change the margin of an existing file, from _______ dialog box.

A Page Setup B Margin

C Document Setup D None of the above

60.The shortcut Key of Text Wrap is ______ in PageMaker.

A Ctrl+Shift+WB Alt+Ctrl+F

C Alt+E D Alt+Ctrl+E

61. The shortcut Key of Show Pasteboard is _________ in PageMaker.

A Ctrl+1 B Alt+Ctrl+P

C Shft+Ctrl+0 D None of the Above

62.The Shortcut key of Show/Hide Guide is _________ in PageMaker.

A Ctrl+] B Ctrl+Alt+'

C Shift+; D Ctrl+;

63. To get set by set print out in PageMaker we use

A Collate B Reverse

C Scale D None of the above

64. ___________ is the process of adjusting space between specific letter pairs in PageMaker.

A Leading B Tracking

C Kerning D None of the above

65. To get the Color Palet option we have to press_____________

A Ctrl+B B Ctrl+J

C Ctrl+8 D None of the above

66. The shortcut key of Paragraph Specefication is ___________

A Ctrl+P B Ctrl+T

C Ctrl+M D None of the above
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67. Minimum Font size is _______________

A 8 pt. B 10 pt.

C 6 pt. D None of the above

68. We can import graphics through _______________ option.

A Import B Insert

C Place D None of the above

69. In PageMaker Shortcut key of Superscript is

A Alt+\ B Ctrl+Shift+\

C Shift+\ D Alt+Shift+Ctrl+\

70. You can create up to __________ culomns in a page in PageMaker.

A 20 B 21

C 8 D 16

71. In PageMaker space between two columns is called

A Leading B Horizontal Scale

C Gutter D Middle margin

72. In PageMaker any file is imported through a __________ with the extension of .FLT

A Filter B OLE

C DDE D File Browser

73. We get Facing Pages option active when ____________ option is on.

A Single Page B Double sided

C Single sided D None of the above

74. In pageMaker the minimum target output resolution that we can set is

A 80 B 100

C 300 D 72

75. The shortcut key to open Go to Page dialog box is

A G B Ctrl+G

C Shift+G D Alt+Ctrl+G

76. We can draw maximum ____________ sided Polygon with the help of Polygon Tool in PageMaker

A 100 B 999

C 99 D Unlimited

77. Maximum Stroke weight is __________ in PageMaker.

A 100 B 800

C 90 D 50

78. Word Counter option is under __________ menu.

A Edit B Element

C View D Utilities

79. In Pagemaker US English option is related to __________.

A Alignment B Language

C Dictionary D English

80. The shortcut key of 50% zoom view in PageMaker is

A Ctrl+5 B Ctrl+2

C Ctrl+Shift+5 D F5

81. The shortcut key of 400% zoom view in PageMaker is

A F4 B Ctrl+8

C Ctrl+Shift+4 D Ctrl+4

82. The shortcut key of 100% zoom view in PageMaker is

A Ctrl+1 B Ctrl+0

C Ctrl+~ D F1

83. The shortcut key of Go to Previous Frame in PageMaker

A Ctrl+Alt+[ B Ctrl+F

C Ctrl+Alt+] D Alt+F

84. The shortcut key of Go to Next Frame in PageMaker.

A Alt+N B Ctrl+N

C Ctrl+Alt+] D Ctrl+Alt+[
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85. There are ________ type of Leading Method in PageMaker.

A Three B One

C Four D None of the above

86. We can set the value of maximum ________ lines for Widow Control.

A 1 B 2

C 3 D 4

87. We can set the value of maximum ___________ for Orphan Control

A 4 B 3

C 2 D 1

88. The shortcut key of underline in PageMaker ________is

A Shift+U B Ctrl+U

C Alt+U D Shift+Ctrl+U

89. We can get __________ types of option for Hyphenation in PageaMaker

A 1 B 2

C 3 D 4


